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------------------------------------------------------------
1.0 - Other Important README Documents
------------------------------------------------------------

See the following documents for more README information:

README.DRVContains additional information on ADI 4.2 
device drivers.

README.ADS Describes the text files that explain how to 
compile, link, and debug AutoCAD Development 
System (ADS) applications, and tells where to 
find them.

README.AME Contains additional information on the AutoCAD 
Advanced Modeling Extension Release 2.1 
(AME R2.1).

README.ASE Contains additional information on the AutoCAD 
SQL Extension (ASE).



README.AVE Contains additional information on AutoCAD
Render.

DDE.TXT Contains additional information on AutoCAD
DDE (dynamic data exchange) support.

--------------------------------------------------------------------
2.0 - Release 12 for Windows Specific Information
--------------------------------------------------------------------

2.1 - Installation with SHARE.EXE

Using backup diskettes formatted with DOS 4.0 or higher may cause difficulties during AutoCAD
installation if the TSR - SHARE.EXE is installed.  If error messages during installation indicate 
that SHARE may be loaded or that there may be an error in a compressed file, reboot without 
SHARE.EXE installed and reinstall AutoCAD for Windows from the beginning.

 2.2 - Running Multiple Licensed Copies of R12 for Windows

Due to the manner in which shared resources are handled, attempting to run multiple licensed 
copies of AutoCAD R12 for Windows on the same computer simultaneously can produce 
unexpected results.  Doing so is not recommended.

2.3 - Model Space Vector Drawing

If you maximize the AutoCAD graphics window while model space vectors are being drawn, the 
final regenerated drawing may be incomplete.  Simply perform a regen in the model space 
viewport or a regenall and the drawing will be correctly displayed.

2.4 - PLINES and the Clipboard

When performing a 'Copy Vectors' menu command:  if a curved polyline with any width other 
than zero is positioned so that it lies outside the clip limits of the current viewport, the clipboard 
representation of the polyline will be incorrect.  To alleviate this problem just perform a regen and
then execute another 'copy vectors' command.  The copied vectors will now display properly in 
the Clipboard.

2.5 - OLE and Microsoft Excel 

If a Microsoft Excel document contains links to more than one AutoCAD drawing, automatic 
updating of the links at startup does not work.  To update the links manually, follow the 
procedures outlined below:

[NOTE:  It is very important to perform these steps in the exact order specified; otherwise, 
AutoCAD may be locked into an indeterminate state, where it will appear frozen.]



1)  Open up AutoCAD.  The editor should contain a saved drawing, or one that is new and 
unedited.

2)  Open the EXCEL document containing the linked AutoCAD drawing objects.

3)  Choose NO to the message box that prompts:

"Re-establish Remote Links?"

4)  In EXCEL, go to the File menu | Links... command to open the Links Dialog.

5)  In the dialog is a List box entitled "Links:".  Choose a SINGLE link and click on the "Open" 
button in the dialog.

6)  AutoCAD will load the linked drawing and restore the named view associated with the link 
that was selected.

7)  AutoCAD will now be in the forefront.  Return to EXCEL, reopen the Links dialog, and select
the same link.

8)  Click on the "Update" or "Change" button as desired, then click on the Close button to exit the
dialog box and initiate the update.

9)  Repeat this procedure for each link in the file.

2.6 - OLE Bitmap Format

If you are interested in transferring drawings in the metafile format (Windows vector format) only
for the OLE feature (Edit menu:  "Copy Link"), then you can add this line to ACAD.INI in the 
[AutoCAD General] section:

[AutoCAD General]
OleBitmap=0

This will reduce the amount of memory needed to copy to the clipboard (for "Copy Link") or to 
update an OLE client application with revised drawing data and images.  The bitmap format must
be used for multiple viewports and paperspace since the metafiles work only for the default 
viewport.

2.7 - DDE 

2.7.1 - Spreadsheet Auto Start

Some of the DDE examples in the Using AutoCAD for Windows manual mention that the DDE 
dialogue will appear.  This is no longer true for spreadsheet applications that can be found in the 
Windows Registration Database.  These will be started automatically without requiring a 
dialogue.



2.7.2 - Using the Shaft Example

The DDE shaft example in the Using AutoCAD for Windows manual does not mention that in 
order to load the shaft menu you need to either open SHAFT.DWG or use the menu command 
from a new drawing to load shaft.mnu by entering "menu shaft.mnu".

2.7.3 - DDE Export 

If a DDE export (from the Edit, DDE, Export Drawing menu item), and import in attribute format
reports that many entities have been modified when none have been changed in a spreadsheet, it 
usually means the attribute data was numeric floating point and the zeros were removed in the 
spreadsheet data.  The numeric value hasn't changed, but the text representation was changed by 
the spreadsheet application.

AutoCAD Spreadsheet
Attribute Cell

13.00 ---> 13
93.00 ---> 93

The format for this column in the spreadsheet should be changed to force two decimal places.  
For example, in Excel, click on the button at the top of the column and use the Format menu to 
select Number and "0.00".

2.7.4  - DDE Advise

The advise AutoLISP function example in the manual shows the use of square brackets around 
the AutoCAD command.  This is no longer needed and will not work.  In the following example 
the "linkcommand" string will work since it contains no square brackets.  Also, the backslash is 
no longer interpreted as a special character in this context.

  (setq linkcommand "(moddrawing 3 20000) ")
  (setq result (advise chnl "R1C1:R45C4" linkcommand)) 

NOTE: The current code only supports one advise item at a time. To work around it, you can set 
an advise for a range of cells and then request data on the range when an advise occurs.  The 
following example, from dde.lsp, makes such a request:

 (setq data (request chnl cell)) ;request-get data from a cell
 (ddefree chnl) ;free request data (shared data from

;  remote app)

Alternatively, ADS developers could change the code in ddewin.c to handle a linked list of advise
items instead of just one for each DDE channel.

See DDE.TXT in the ads\win directory for more details on DDE.



2.7.5 - AutoLISP DDE Dialogue

The DDE dialogue run from AutoLISP with the (ddedialog) function conflicts with the dialogue 
run from the Edit menu, DDE, DDE Dialog.  If you need to use both and have either a Microsoft  
or a Borland C compiler, you could rename the function in either ddeads.c or ddelisp.c from 
ddedialog to some other name and rebuild the DDE executables using the DDE make file in ads\
win.

2.7.6 - Working with Lotus 123w

For exchanging data with Lotus 123w or 123 compatible spreadsheets, you will have to use the 
new "Parameters" button on the DDE dialogue (from the Edit menu, DDE selection) to change 
the way DDE items are expressed.  In the "Spreadsheet Parameters" dialogue, click the "Other" 
radio button.  Delete all characters in the "Row Spec:", "Column Spec:", and "Open Command:" 
edit boxes.  Change the "Range Delimiter:" to ".." and Default Document to "Untitled".

o Microsoft Excel (English)
x Other

Row Spec:
Column Spec:
Range Delimiter: ..
Open Command:
Default Document: Untitled

This information will be saved in the Windows directory, ddeads.ini.  You won't have to enter 
these options again later. For users of dde.lsp, the dialogue must be run with the command 
"(ddedialog)", which will save the information in ddelisp.ini.

2.8 - Configuring for Multiple Sessions

There are two different methods that may be employed to provide configuration files for use with 
multiple sessions of AutoCAD.  We recommend the second of the two methods described below.

2.8.1 - Single Configuration File

The default installation provides a single start-up icon.  The properties of this start-up icon point 
to the location of the AutoCAD executable as the location of the configuration file.  If you start 
multiple sessions by repeatedly double-clicking on this icon, all sessions will share a single 
configuration file.   While multiple sessions are in progress , it is very important that you do not 
reconfigure for new or different peripheral devices.  If you do so, unexpected results may occur.

2.8.2 -  Multiple Configuration Files 

Although the default installation of AutoCAD provides a single configuration file, much greater 
flexibility and control will be obtained by using the /C command switch option  (see page 57 of 
your Installation and Performance Guide for details).



For example, if you wish to run two sessions of AutoCAD, create a copy of your startup icon.  
Edit the properties command line (see page 54 -55 of the Installation and Performance Guide) of 
the newly created icon.   Adding the /C switch will cause the new session to place its 
configuration files in the directory designated by the  switch.  In addition, edit the label of this 
icon. Change the name to: "Session 2", or something appropriate.  

If you wish to run a third session, repeat the above steps for a third icon.

2.9 - Disabled Scrollbars

When configured for the non-accelerated Windows display driver, scrollbars will be disabled 
while working in Paper Space and when Fast Zoom mode is turned off.

2.10 - Peripheral Information

Because AutoCAD is tested with the newest hardware devices available, we cannot insure 
consistent results for very old, outdated equipment.

2.10.1 - System Printer

To set the default AutoCAD system printer, select the device name from the installed printer list 
in Window's Control Panel applet.  To select an installed system printer from within AutoCAD, 
click first on the Device and Default Selection button from within the Plot Configuration 
Dialogue box and then click the "Specific Printer" button.  Finally, select the printer from the list 
of available printers.

2.10.2 - Digitizer Mole Mode Audible Indicator

The digitizer mole mode audible indicator and system level sound drivers may not be compatible.
Using both of these together may cause both AutoCAD and Windows to terminate unexpectedly.  
If you have enabled the mole mode audible indicator and system sound drivers, test the setup 
before using AutoCAD for production level work. 

To perform this test, configure for a mole context and rapidly move between the digitizer and 
mole contexts. If everything is working correctly you will hear the sound corresponding to the 
SystemDefault sound every time you move to a different context.  If the system terminates you 
can either turn off the audible mole indicator, or uninstall the system sound drivers from the 
Control Panel's 'Drivers' applet.

2.10.3 - "Older" Summagraphics MM Digitizers

While in Mole Mode, changing focus to another window may fail when using Summagraphics 
MM models that use the "older" cable configuration specified in the R12 AutoCAD for Windows 
Installation and Performance Guide.  These devices are several years old and their hardware 
design causes inconsistent behavior.



2.10.4 - Kurta IS/THREE Digitizer

You may experience cursor lag when using the Kurta IS/THREE digitizing tablet.  This is due to 
the tablet's hardware design and therefore cannot be improved in R12 AutoCAD for Windows.

2.10.5 - CalComp Plotters

On the CalComp plotter drivers, occasionally a line may be drawn incorrectly.  To fix this, 
reconfigure the plotter and change the Optimization Level from the default of  '0' to a level of '1'.

2.11 - Note About "Screen Savers" and Digitizers

In general, if a "screen saver" has not been specifically designed for Windows 3.1, there is no way
for a digitizer to inhibit the "screen saver" execution once it has started.  If you encounter such a 
situation, we recommend contacting the "screen saver" vendor and requesting an update.

-----------------------------------------------------------------------
3.0 - General R12 Platform-Independent Information
-----------------------------------------------------------------------

3.1 - Using Custom Menus

Many Release 12 features are implemented as external ADS and AutoLISP applications. These 
applications are made available to you by the loading of the file acadr12.lsp. This file is 
automatically loaded when the standard menu that is installed with Release 12 (acad.mnu) is 
loaded.  If acadr12.lsp is not loaded, many features, such as the region modeler, AVE Render, and 
various dialogues, will not be available.

If you are using an older menu, or any menu other than the one installed with AutoCAD Release 
12, you must make sure that acadr12.lsp is loaded.  To load acadr12.lsp, insert the following line 
in the menu's .mnl file, if it exists, or in acad.lsp:

(load "acadr12")

3.2 - Entity Sorting/Drawing Order

The SORTENTS system variable determines whether or not entities are processed in database 
order by various AutoCAD operations. By default, this is set to 96 (entity sorting for plotting and 
PostScript output only). If it is important for the display and selection of entities to have a 
predictable order, you can change the setting of SORTENTS as desired. However, specifying 
sorting for additional types of AutoCAD operations can significantly affect AutoCAD's 
performance in large drawings (especially the time required for a REGEN, if bit value 16 is set in 
SORTENTS). See  "Entity Sort Method..." on page 29 in the AutoCAD Reference Manual.



3.3 - AutoCAD Release 12 Memory Use

In Release 12, AutoCAD makes more aggressive use of memory than ever before.  Various 
commands such as Hide, Regen, and Render use memory intensively and in return either run 
faster or offer extended capabilities.  Because of these changes, optimizing memory use and the 
location of temporary and paging files is increasingly important.

3.4 - AVE Render and New Drawings

You cannot create a completely empty new drawing if AVE Render is loaded. If you want to load 
a complete DXF or IGES file when AVE Render is loaded, you must first unload AVE Render. To 
do so, select Unload Render from the Render pull-down or use the following command line 
syntax:

Command: (xunload "averendr")

Then use the NEW command to obtain a new drawing. (Note: If your configured prototype 
drawing is not an empty one, you'll also need to select the "No Prototype" toggle in the New 
Drawing dialogue box.)

3.5 - Automatic Timed Save Feature

The new Automatic Timed Save feature has replaced the Spacer File mechanism previously used 
by AutoCAD to reserve hard disk space for the drawing currently being edited. This feature, 
common to most programs, saves your drawing file on a regular, user-defined, interval. See 
"Automatic Timed Save" on page 79 in the AutoCAD Reference Manual.

3.6 - Moving the AutoCAD Program Files

If you move your AutoCAD program files to a different directory after initial configuration, you 
will need to reconfigure AutoCAD. This is because the entire path to the drivers is saved in the 
acad.cfg file.

3.7 - Quitting a Drawing from a Script

Scripts do not call the Drawing Modification dialogue box that appears when you issue QUIT, 
NEW, or OPEN from a drawing with unsaved changes. A script that uses QUIT, NEW, or OPEN 
should follow these commands with Y (discard all changes) or N (don't discard changes) -- not 
with S (Save Changes) or D (Discard Changes).

3.8 - TABLET Command Compatibility

Due to changes in the TABLET Cfg and TABLET Cal commands, scripts, menu items, the 
AutoLISP (command) function, and the ADS ads_command() function may now supply input at 
the "Digitize point:" prompts of these commands. Where previously AutoCAD waited for the user
to digitize a point at these prompts, now it is necessary to supply explicit pauses to make it do so. 
Since scripts have no mechanism for pausing, these commands should not be used in a script.



See the section entitled "TABLET command", starting on page 94 of the AutoCAD Reference 
Manual, for a complete description of the new tablet calibration options. Also see the AutoLISP 
Programmer's Reference and the ADS Programmer's Reference for information on the (tablet) 
and ads_tablet() functions.

3.9 - UNNAMED drawings

Prior to Release 12 it was impossible to start a drawing without previously naming it. With 
Release 12, when you start AutoCAD without providing a drawing name, you are editing a 
drawing named "UNNAMED" until you specifically name it with SAVE, SAVEAS, or other 
commands that force you to provide a name for the drawing. If you plot this drawing to a file 
before naming it and don't supply an explicit name for the plot file, it will be named unnamed.plt. 
Also, in the unlikely event that you crash, AutoCAD gives you the option to save the drawing. If 
this drawing has not yet been named, AutoCAD saves it as unnamed.dwg.

3.10 - Using Files from a Read-Only Directory

By default, AutoCAD creates temporary paging files in the same directory as the current drawing.
If you have not changed the default configuration and you attempt to open a drawing in a read-
only directory you will get the following message:

+---------------------------------------------------------------------------+
| AutoCAD  Alert |
+---------------------------------------------------------------------------+
|    To access files in a read-only directory, you must configure |
|    a temporary file location other than  DRAWING |
| |
|                                        [ OK ] |
+---------------------------------------------------------------------------+

Examples of read-only media include write-protected floppy disks, read-only network directories,
and CD-ROMs. To open a drawing in a read-only directory (or drive), you will need to specify 
the name of a writeable directory where AutoCAD can create temporary paging files. Option 5 of 
the Configure Operating Parameters submenu of the Main Configuration menu lets you do this. 
See your AutoCAD Interface, Installation, and Performance Guide (and later sections of this 
README) for more information on temporary paging files.

3.11 - Programming with the Get File Dialogue

The AutoCAD Development System Programmer's Reference manual (p 156) states "The string 
in the result argument, result->resval.rstring, must point to a memory area large enough to store a 
pathname string."  This is erroneous.

The ads_getfiled() function does not always return a pathname.  If the user dismisses the dialogue
by pressing the "Type It" button, the dialogue returns an integer value equal to 1.  For this reason 
it is necessary for the ADS library to allocate the memory needed to store the pathname if a 
pathname is returned.  If the caller attempts to allocate a memory buffer for this purpose, the 
pointer passed into ads_getfiled will be ignored and the buffer may become inaccessible.



According to the AutoCAD Development Systems Manual, and the AutoLISP
Programmers Reference Manual, if the flags bit 1 is set (Value = 2), the 'Type it' button will be 
disabled.  This implies that the programmer would not need to test for the return values caused by
the user pressing this button.

However, if the NULL display driver is configured, ads_getfiled() and (getfiled) always returns 
these values - no matter what the flags setting is.  Therefore, the programmer must test for these 
values, even if flags is set to 2.

--------------------------------------------------------
4.0 - General R12 Questions and Answers
--------------------------------------------------------

4.1 - AutoCAD Release 12 for Windows Questions & Answers

4.1.1 - Windows-Specific Questions

Q. What are the system recommendations for AutoCAD Release 12 for Windows?

A. An 80386- or 80486-based computer; a hardware math co-processor is required.
MS-DOS 3.31 or higher; MS-DOS 5.0 recommended
Microsoft Windows 3.1 in 386-enhanced mode
8 MB RAM recommended
An additional 4.5 MB RAM needed for each additional active AutoCAD session
A permanent swap file 4 times larger than physical RAM is recommended
Windows pointing device
At least 8 MB free disk space for minimal installation
33 MB free disk space for a full installation

Q.  Why do imported metafiles display as outlines (non-filled images)?

A.  By default, AutoCAD imports Windows metafiles (WMF) as AutoCAD blocks containing 
polyline entities.  To bring in filled images, change the menu selection in the "WMF In Options" 
dialogue box located under "Import/Export" in the "File" pull-down menu, or issue the 
WMFOPTS command.

Q.  Why does AutoCAD ignore my first command when I start the program?

A.  AutoCAD ignores all commands and menu picks issued before the AutoCAD menu is loaded. 
Wait until the "Command:" prompt appears on the command line before typing or picking 
commands.

Q.  How do I set the size and shape of the AutoCAD toolbox?

A. The toolbox size and shape can be changed by clicking the right mouse button while 
positioned over any of the toolbox buttons.  In the group labelled "Toolbox width," the width can 
be set for floating and stationary toolboxes.  To save your changes permanently, make sure the 
"Save in ACAD.INI" option is selected.



Q.  After customizing the buttons in the toolbox, the following error occurs when clicking on an 
icon button:

"Unknown command.  Type ? for list of commands."

A.  The command string associated with that button is not a valid AutoCAD command.  To 
correct this problem, enter the "Toolbox Customization" dialogue box by clicking on the right 
mouse button and selecting the icon in question. Correct the command string displayed at the 
bottom of the dialogue in the edit box.

Note: This also applies to toolbar menus.

Q.  How do I add or modify the icons for the toolbar, toolbox, or menus?

A.  The bitmap images in the toolbar, toolbox, and menus can be changed with a resource editor 
like Borland's Resource Editor, Whitewater's Resource Toolkit, or by using either Borland C/C++ 
or Microsoft C/C++ along with the batch files and instructions contained in the file BITMAP.ZIP, 
available on CompuServe.

Note: The bitmaps in AutoCAD menus can not be modified with a standard icon image editor.

Q.  Why does AutoCAD start without configuration files when opening a linked or embedded 
drawing?

A.  If AutoCAD's configuration file is in a directory other than AutoCAD's main directory, then 
the DOS environment variable ACADCFGW must be set before entering Windows.  (AutoCAD 
ignores the /C, /D, /M, and /S command line variables when started from OLE).

Q.  Why does Windows sometimes start a new AutoCAD session and other times open the file in 
an existing session when I click to edit an embedded or linked drawing in another application?

A.  Embedded and linked files are edited only in a primary session of AutoCAD.  If you started 
two AutoCAD sessions and closed the first, OLE then needs to start a new primary session to edit
the drawing.  If the primary session of AutoCAD is still running, OLE will open the file in that 
AutoCAD session (essentially issuing an OPEN command, giving you the chance to save your 
work before loading the OLE drawing).

Q.   How do I make AutoCAD open a new session each time I double-click on a drawing file in 
the File Manager instead of opening each drawing in the original drawing session?

A.  To allow AutoCAD to start a new session each drawing file, issue the following steps:
a) From the Program Manager load the Registration Information Editor: 

File/Run REGEDIT.EXE.
b) Double-click on the words "AutoCAD Drawing."
c) Unselect the "Uses DDE" checkbox.
d) Add a "%1" to the end of the "Command:" edit box.

Example:  C:\ACADWIN\ACAD.EXE  %1
e) Click on OK.
f) Exit the Registration Information Editor.



Q.  Why do I get the message that "Windows Help for AutoCAD is not available."?

A.  AutoCAD is unable to locate the help file, ACADWIN.HLP.  To specify the help file location, 
open the "Preferences" dialogue box, click on the "Environment" button and edit the path for the 
help file.  The help file is placed (by default) in the C:\ACADWIN\SUPPORT directory during 
installation.

Q.  Why does Norton Desktop for Windows give the following message when files are dragged 
and dropped onto an AutoCAD session? 

"No association exists for file."

A.  Norton Desktop for Windows does not support drag-and-drop for AutoCAD.  You must use 
the Windows File Manager.  Creating associations in Norton Desktop or File Manager will have 
no effect on the drag-and-drop capabilities of Norton's drive windows.

Q.  Why do AutoCAD's README files have strange characters in them?

A.  The README files which ship with AutoCAD for Windows are in Windows Write format. 
Use Windows WRITE.EXE to view them.

Q.  How do I toggle back and forth between the text and graphics window?

A.  Use the F2 function key.  The F1 function key follows Windows key shortcut standards and 
displays Help.

Q.  How do I control the base point of entities copied using the "Copy Vectors" command in the 
"Edit" pull-down menu?  

A.  AutoCAD uses the origin of the drawing as the base point for entities copied with the "Copy 
Vector" command.  Use the BASE command to change the base point of your drawing.

Q.  Why is the "Copy Link" command sometimes grayed-out on the "Edit" pull-down menu?

A.  AutoCAD requires that the drawing must have a name before it can be linked to another 
application.  The "Copy Link" command will appear normally as soon as the drawing is saved.

4.1.2 - Configuration

Q.  How do I specify environment variables for AutoCAD for Windows?

A.  AutoCAD for Windows accepts environment variables from either the DOS SET statement, a 
command-line switch associated with the AutoCAD icon, or by values in the 
Preferences/Environment dialogue box.  The Installation and Performance Guide has a complete 
explanation of AutoCAD's environment variables.



Q.  Why does launching AutoCAD by double-clicking on a drawing file in the File Manager 
cause AutoCAD to load but give the following error and force a reconfiguration?

"Error loading dialogue control file."

A.  AutoCAD is being started without its environment switches.  Use the Windows Registration 
Information Editor to add the "/C" configuration command line switch to AutoCAD's command 
line.

a) From the Program Manager load the Registration Information Editor: 
File/Run REGEDIT.EXE.

b) Double-click on the words "AutoCAD Drawing."
d) Add the /C switch to the command line just after ACAD.EXE.

Example:  C:\ACADWIN\ACAD.EXE  /C  C:\ACADWIN\ALTCONF
d) Click on OK.
e) Exit the Registration Information Editor. 

Note: If the above error message is encountered when starting AutoCAD by double-clicking on 
the AutoCAD icon, see question #3 (next) for more information about how AutoCAD searches 
for the configuration files.

Q.  Why doesn't AutoCAD find my support files in the correct directory?

A.  Since there are many ways to specify support paths for AutoCAD, there is a search path 
precedence.  The highest priority for finding files is given to the command line switches (/C, 
/S, /M, or /D) appropriately.  If none of these switches has been set, AutoCAD looks to the 
settings in the ACAD.INI file.  If there are no settings for these variables there, AutoCAD looks 
for the DOS environment variable ACADCFGW.  If none of these has been set, then AutoCAD 
looks only in the ACAD directory.

Q.  How can I specify different configurations for each concurrent session of AutoCAD?

A.  Create multiple copies of the AutoCAD icon and modify the configuration switches 
associated with each icon:

a) Create a directory for AutoCAD's alternate configuration files.
b) Copy the files ACAD.INI and ACAD.CFG into the alternate configuration 

    directory.
c) Press the Control key and drag the AutoCAD icon to copy it.
d) Click once on the new AutoCAD icon.
e) Press Alt-Enter to start the Program Item Properties dialogue.
f) Add the /C switch to the command line just after ACAD.EXE.

Example:  C:\ACADWIN\ACAD.EXE  /C  C:\ACADWIN\ALTCONF
g) Click on OK.

Note: Each AutoCAD configuration requires a separate copy of the configuration files 
ACAD.CFG and ACAD.INI.



Q.  How do I start AutoCAD's freeplot option?

A.  Freeplot is issued by adding the -P switch to the AutoCAD command line.  
a) Click one time on the AutoCAD icon to highlight it.
b) Press Alt-Enter to start Program Item Properties dialogue.
c) Add the -P switch to the command line switch just after ACAD.EXE.

Example:  C:\ACADWIN\ACAD.EXE  -P
d) Click on OK.

Q.  How do I reconfigure AutoCAD before it loads?

A.  Reconfigure AutoCAD by adding the -R switch to the AutoCAD command line.
a) Click one time on the AutoCAD icon to highlight it.
b) Press Alt-Enter to start Program Item Properties dialogue.
c) Add the -R switch to the command line switch just after ACAD.EXE.

Example:  C:\ACADWIN\ACAD.EXE  -R
d) Click on OK.

Q.  What can be done to make AutoCAD faster?

A.  Creating a large permanent swap file will help significantly.  

Q.  How do I create a permanent swap file?

A.  Since Windows requires that permanent swap files must be created in contiguous space on the
disk,  it may be necessary to optimize the disk with a program like Speed Disk by Norton 
Utilities, before a large swap file can be created.  

a) Choose the Control Panel from the Program Manager.
b) Choose the 386 Enhanced icon.
c) Select the Virtual Memory button.
d) Select the Change button.
e) Change the "Type:" selection to "Permanent".
f) Confirm that the "New Size" selection is the desirable size.
   (If possible, create a swap size four times larger than physical RAM memory.)
g) Click on OK.

Note: These same steps, except step e), can also be used to increase the size of the permanent 
swap file.  Consult the Microsoft User's Guide for more information about swap files.

Q.  Will AutoCAD R12 for Windows run under OS/2 2.0?

A.  No.  AutoCAD for Windows will run in OS/2 2.1; however, it has not been exhaustively 
tested and is not supported in that environment.    

Q.  Will the drivers used in AutoCAD R12-386 or AutoCAD Extension for Windows work with 
Release 12 for Windows?

A.  No.  AutoCAD R12 for Windows requires drivers written especially for it.  Older ADI drivers 
or drivers built for R12-386 will not work. 



4.1.3 - Display

Q.  How can I get my Aerial view window back after I close it?

A.  The Aerial view can be started by either clicking on the compass icon on the toolbar, or by 
issuing the command DSVIEWER. 

Q.  Where is AutoCAD's screen menu which is normally visible on the right side of the display?

A.  AutoCAD ships with the screen menu turned off.  To turn it on, click on the Screen Menu box 
in the AutoCAD Preferences dialogue which can be accessed by either clicking on "Preferences" 
under the "File" menu, or by typing the command PREFERENCES.

Q.  Why is the Scroll Bar option in the Preferences dialogue grayed out?

A.  Scroll bars are only supported when using the regular, non-accelerated display driver in non-
perspective modelspace viewports.  Paperspace and perspective views do not offer scroll bar 
support.  When using the accelerated display driver, the Aerial view tool provides quick panning 
and zooming functions.

Q.   Why does the aerial view sometimes not zoom to the extents of the drawing?

A.  The Aerial view window displays only the region contained in the display list.  It will not 
zoom in or out farther than the display list because this would cause a drawing regeneration.  To 
recalculate the extents of the drawing and allow Aerial view to frame the entire drawing, issue a 
ZOOM EXTENTS command in the drawing editor. 

Q.  When zooming and panning in the Aerial view, how do you update the graphics screen to 
match the view in the Aerial view?

A.  Double-click on the word ZOOM in the Aerial view to make the AutoCAD display match it.

Q.  Why does selecting the Aerial view button in the toolbar return the message 

      "DSVIEWER Unknown command. Type ? for list of commands."?

A. The Aerial view window is only available when AutoCAD is using the accelerated display 
driver.  To use the accelerated display driver, reconfigure AutoCAD's display using the CONFIG 
command or select "Configure" from the "File" pull-down menu.  The DSVIEWER command 
will bring up the Aerial view window when the display-list driver is configured, and when the 
current view is non-perspective in modelspace.  

4.1.4 - Networking

Q. Will AutoCAD Release 12 for Windows work with Windows for Workgroups?

A.  Yes.  It has not been exhaustively tested, and is not supported in this environment.



Q.  Why does AutoCAD create files with .AC$ extensions even when the AutoCAD Page 
Directory variable ACADPAGEDIR in the Environment dialogue box is set to the local drive?

A.  The ACADPAGEDIR variable only redirects AutoCAD's page files.  To redirect AutoCAD's 
temporary files -- those files with .AC$ extensions -- you must change the "Placement of 
Temporary Files" option in AutoCAD's configuration menu.  This option is located under  
"Configure Operating Parameters" on the Configuration menu.

4.1.5 - Digitizers

Q.  What is a mole mode area?

A.  A mole mode area is a portion of the digitizer where the digitizer puck acts like a system 
pointing device or mouse.    

Q.  What is the difference between a mole mode area and a toggle area?

A.  When the puck is moved into a mole mode area, only that portion of the tablet acts like the 
system pointing device.  When the puck is moved into a toggle area, the entire tablet switches 
between being either a system pointer or an AutoCAD pointer

Q.  What is the difference between a primary and secondary mole mode area?

A.  Primary and secondary mole mode areas allow you to have two different resolutions for a 
system pointing device.
 
Q.  What is the difference between primary and secondary toggle areas?

A.  The primary toggle area switches between AutoCAD pointer mode and system pointer mode.  
The secondary toggle switches between the primary and secondary mole mode areas.

Q.  How can I use my digitizer as my main system pointer in Windows and as a digitizer in 
AutoCAD?

A.  If you have your digitizer configured as your main system pointing device in Windows, you 
must select the "System Pointing Device" in AutoCAD and it will effectively operate as a mouse 
(in relative mode).  If you wish to use the digitizer as your Windows pointing device and as a 
tablet in AutoCAD (in absolute mode), you must instead use a WINTAB driver for Windows.  
WINTAB drivers must be installed as your system pointing device in Windows before starting 
AutoCAD, and are available through your digitizer vendor.  Mole mode drivers in AutoCAD can 
only be used if you have a separate mouse installed as your system pointing device in Windows.



4.1.6 - Plotting / Printing

Q.  Why is the AutoCAD system printer in the Plot dialogue different from the system printer 
configured in Windows?

A.  During configuration, AutoCAD stores the current Windows system printer information.  To 
update AutoCAD's system printer and make it match Window's system printer, reconfigure 
AutoCAD's plotters, modify the system printer entry, and reselect the system printer.  Another 
method is to select another printer in the "Change Device Requirements" dialogue box in 
AutoCAD's Plot Configuration dialogue.  The latter choice will allow you to choose from those 
printers which have been configured in the Windows Control Panel.

Q.  How does plot spooling work with AutoCAD for Windows?

A.  If you are using a Windows system printer, all plot spooling must be done by the Windows 
Print Manager.  If you are using an AutoCAD plotter driver other than the system printer, plot 
spooling must be done with AutoCAD's AUTOSPOOL mechanism.  For complete information on
setting up AUTOSPOOL, see the section "Step-by-Step Setup for Plot Spooling" in the AutoCAD
Installation and Performance Guide.
 
Q.  How do I change between different printers using AUTOSPOOL?

A.  You can toggle which plotter AUTOSPOOL sends the plot file to by changing the Plotting 
variable in the Environment dialogue.

a) Specify a plot spooling directory using option 4, under "Configuration 
    Operating Parameters," in the configuration menu. 

b) Enter the default plot file name of AUTOSPOOL in option 3 of the Operating 
    Parameters menu.

c) Create different spooling batch files for each device.  For example, if you 
    have a network with a Hewlett-Packard plotter connected to the LPT2 

port and     a Calcomp plotter connected to the LPT3 port, then your spool
files would     look like this:

HPSPOOL.BAT
   @echo off
   copy /b %1 lpt2: > NUL
   del %1 > NUL

CALCOMP.BAT
   @echo off
   copy /b %1 lpt3: >NUL
   del %1 >NUL

d) To spool files to the HP plotter, in the Environment dialogue box change the 
    Plotting variable to:
C:\SPFILES\HPSPOOL.BAT %s

e) To spool files to the Calcomp plotter, in the Environment dialogue box change 
        the Plotting variable to:

C:\SPFILES\CALCOMP.BAT %s



Q.  Every time I select a different system printer, I get a dialogue box asking me to configure for 
pure colors or dithered colors.  Which should I select?

A.  For most printers, the pure colors choice is correct because many of them do not support 
dithering.  If your device supports dithering or you are using a color printer, you should choose 
the dithered option.  If you are using dithered colors and you notice that your lines appear dashed,
switch to pure color.  An easy way to tell which is best for your specific printer is to print the file 
CHROMA.DWG using each option, and compare the results.

Q.  How do I import HPGL files into other Windows applications?

A.  If you want to import an HPGL file into Windows applications, configure AutoCAD for an 
HP model 7220 plotter.

4.1.7 - AutoLISP / AutoCAD Development System (ADS)

Q.  Will Release 12 DOS version ADS programs work with R12 for Windows?

A.   No.  You must have a Windows-specific ADS version for R12 for Windows.  This means that 
you will have to either recompile your ADS programs using Windows libraries, or consult your 
program vendor for an update to run with R12 for Windows.

Q.  Will my AutoLisp routines created for Release 12 DOS work with R12 for Windows?

A.  Yes.  All AutoLISP routines should work with R12 for Windows.

Q.  Is there a limit to the number of ADS applications that can be loaded?

A.  There is no limit on the number of protected-mode (32-bit) ADS programs that can be run 
with AutoCAD (assuming you have enough memory).  There is a limit of only one real-mode 
(16-bit) ADS program that can be run on a single machine.

4.1.8 - AutoCAD Visualization Extension (AVE) Render

Q. What is the MDI window and when should I use it?

A.  The Multiple Document Interface (MDI) window, a new feature in Release 12 for Windows, 
allows you to create multiple renderings and view them simultaneously.  The MDI window can be
configured as either your rendering display or rendering hardcopy or as both. Rendering to the 
MDI window allows you to: copy your rendering to the clipboard and paste it in other documents,
save it as a separate file, or print it across multiple sheets of paper.  Consult the Using AutoCAD 
for Windows manual for more details.

Q. How do I get renderings from the MDI window into my drawing?

A.  Images rendered using AVE's full render and no smooth options can be imported into 
AutoCAD by copying the image to the clipboard and pasting it into the drawing.  These images 
can also be saved as metafiles (WMF), and later imported using the WMFIN command.



Q.  How do I change printer settings from the MDI window?

A.  The choice of printers for the MDI window is limited to those printers available through the 
Windows Control Panel.  To change the current printer or the page setup, you must make the 
changes in the Windows Control Panel (Printers option) prior to printing from the MDI window.

4.1.9 - AutoCAD SQL Extension (ASE)

Q.  How do I set the environment variables for DBMS drivers?

A.  You need to set the appropriate environment variables in DOS prior to entering Windows.  It 
is a good idea to add the "set" statements to AUTOEXEC.BAT.

Q.  What is an ODBC driver and how do I get one?

A.  The Microsoft Open Database Connectivity (ODBC) interface lets applications like AutoCAD
access data in a Database Management System (DBMS) using Structured Query Language 
(SQL).  ODBC drivers are available from your database manufacturer.  To use an ODBC driver:

a) Load the driver according to the manufacturer's instructions.  
b) Use the ASESETDBMS command to select ODBC.
c) Enter the logical database name.
d) Reference the ODBC documentation for more specific information about the 

    driver.

Note: See chapter 5 of the Installation and Performance Guide for a complete explanation of 
ODBC drivers.  

Q.  How do I get ASE to work with Paradox for Windows?

A.  To use ASE with Paradox for Windows, you need to run Paradox in version 3.5 compatibility 
mode.  

Q.  Will Release 12 386 drawings with ASE links work in R12 for Windows?

A. Yes, AutoCAD Release 12 for Windows supports ASE drawings created in R12 386.

Q.  Why can I only run one session of ASE?

A.  AutoCAD for Windows can only run one 16-bit ADS application at a time.  ASE is a 16-bit 
ADS application.

4.1.10 - Advanced Modeling Extension (AME)

Q.  Do I need a new version of AME to work with R12 for Windows?

A.   Yes.  You will need the Windows-specific version of AME 2.1 to work with Release 12 for 
Windows.  There is no additional upgrade cost for current AME 2.1 customers.



Q.  Can I copy AME models using the Copy Vectors and Paste commands?

A.  No.  AME models must be exported and imported using the WBLKSOL and INSRTSOL 
commands in the WBLKSOL.LSP bonus routine.  See the Advanced Modeling Extension Release
2.1 Reference Manual for more information on this bonus routine.

4.2 - General R12 Questions and Answers

The following questions pertain primarily to Release 12 DOS 386.  Although the Q & A's are 
pertinent to the Windows release, you are encouraged to reference Using AutoCAD for Windows 
and AutoCAD R12 Installation and Performance Guide for Windows when appropriate.  This is 
especially important regarding questions relating to Environment Variables and Configuration.

Q.  I have script files to do my plotting, but these no longer work.  Why?

A.  Some of the major enhancements to AutoCAD R12 are in the PLOT command.  
Unfortunately, old plotting scripts will no longer work because the command has been so 
completely altered.  To force AutoCAD to follow pre-R12 formats, set the system variable 
CDMDIA to 0.

Command:  cmddia 0

In R12, AutoLISP now remains active during the PLOT command; new AutoLISP functions can 
be written to do an even better job of plotting than pre-R12 scripts.  Here is an example of an R12
PLOT command written in AutoLISP:

Command:  (command "plot" "e" "n" "filename" "")

Q.  AutoCAD doesn't locate any of my drivers during configuration.  What's wrong?

A.  The environment variable ACADDRV is not set to the directory containing the AutoCAD 
drivers.  By default, the drivers are placed in the \drv directory.  See your AutoCAD Interface, 
Installation, and Performance Guide for more information.

Q.  When I use the menu I frequently get the error message: "Unknown command.  Type ? for list
of commands."  What's wrong?

A.  AutoCAD is unable to locate the menu lisp file.  The menu file for R12 has been broken into 
two parts, the standard menu file, acad.mnu, and the AutoLISP menu file, acad.mnl.  These files 
must be located in the same directory and have like names.  See page 112 of the AutoCAD 
Customization Manual for more information on .mnl files.

Q.  What is base.dcl?  Why does AutoCAD report that it cannot be found?

A.  AutoCAD R12 has customizable dialogue boxes.  The definitions for these are stored in .dcl 
files.  The file base.dcl contains basic dialogue definitions used in the layout for AutoCAD's 
internal dialogue boxes, as well as items useful to application developers.  If AutoCAD cannot 
find base.dcl it usually means that the AutoCAD \support directory has not been added to the 
ACAD environment variable.



Q.  Occasionally when I enter AutoCAD, I receive an error message report that the digitizer is not
responding or Analog Circuitry Failure.  In the past, a PLOT command followed by a Control-C 
would restart the tablet.

A.  R12 has a new command called REINIT which will reinitialize the digitizer, the plotter, the 
display, or the .pgp file. NOTE:  You can also use the RE-INIT System Variable, see the 
AutoCAD Reference Manual for more information.  

Q.  I installed AutoCAD R12 but now I have to reconfigure whenever I go from R11 to R12 or 
vice-versa.

A.  If you have two versions of AutoCAD installed on the same computer, you must specify a 
different location for the acad.cfg by using the ACADCFG environment variable.

Q.  How do I reconfigure AutoCAD now that there is no main menu?

A.  To configure AutoCAD R12, you can specify the -R command line option to the ACAD 
executable (ACAD -R), type CONFIG at AutoCAD's command prompt, or select Configure from 
the File pull-down menu.

Q.  Where can I get more PostScript fonts?

A.  AutoCAD uses any Type 1 PostScript fonts.  They are sold by a variety of vendors and are 
available at local computer stores.  See chapter 10 of the Customization Manual for additional 
information.

Q.  Can I distribute an .shx file which I have compiled from a font supplier's .pfb file?

A.  No.  The font supplier's copyright prohibits distribution of any files derived from their .pfb 
files.

Q.  Why don't I get PostScript fonts when I plot with PSOUT?

A.  The acad.psf file contains the logical mapping between the AutoCAD font name and the 
PostScript font name.  This font mapping references the .shx or .pfb file name and not the 
AutoCAD style name.  For more information refer to the text included in the acad.psf file and 
chapter 10 of the AutoCAD Customization Manual.

Q.  Where is the PRPLOT Command?

A.  The PRPLOT command is now part of the PLOT command. Printers and printer plotters are 
handled just like plotters, and can be configured by the Configure plotters option of the CONFIG 
command. All plotter and printer plotter drivers are discussed in appendix C of your AutoCAD 
Interface, Installation, and Performance Guide.



------------------------------------------------------
5.0 - Manual Corrections and Additions
-----------------------------------------------------

5.1 Using AutoCAD for Windows

Chapter 2

- The first page indicates that the ACADWIN.HLP file is in the executables directory (\acadwin) 
by default.  This is not correct. ACADWIN.HLP is in the support directory by default (acadwin\
support).

Appendix A

- Table - Page 191, Modify/Break Submenu. 1st line (Select Object, 2nd point) Command line 
equivalent should be BREAK on its own, not BREAK P.

- Table - Page 191. 2nd line (Select Object, Two Points) Command line equivalent should be 
BREAK F not BREAK F P.

- Render Menu Table - page 193,  Unload Render Command.  Command Line equivalent should 
be AI_UNLOADAVE not UNLOAD.

5.2 - AutoCAD Reference Manual

Chapter 6

- "PEDIT Command--Polyline/Mesh Editing", page 243. The following should be added to the 
discussion of the Join option of PEDIT:

Note: Using the Join option on a curve-fit Polyline removes the curve  fitting.

Chapter 13

- "Freeplotting - Using AutoCAD to Plot", page 545. The following should be added to the 
description of using a script with Freeplotting:

- In Freeplot, AutoCAD prompts for the drawing name after the PLOT command is issued.  When
plotting from a script, you must provide the drawing name after the PLOT command.

Appendix A

- "PostScript Fonts", page 580.  The name of the PanRoman font "Pan" is incorrect, it should be 
"Par".



5.3 - AutoCAD Customization Manual

Chapter 5

- "Shape Descriptions", page 51. The first sentence of the fifth paragraph in this section should be
replaced with the following:

- Every shape in a particular shape file must have a unique number between 1 and 258 (numbers 
256, 257, and 258 are for the symbolic identifiers "Degree_Sign", "Plus_Or_Minus_Sign", and 
"Diameter_Symbol").

Chapter 7

- "Invoking a Script When Loading AutoCAD", page 102.  The following sentence should be 
added to the Note about Freeplotting:

- See the AutoCAD Reference Manual for information on the Freeplot feature.

Chapter 11

- "HEADER Section", page 252.  The $DWGCODEPAGE variable is listed as a type 70. This is 
incorrect; it is really a type 3.

- "TABLES Section", page 258.  A portion of the description in the VPORTS group is incorrect.  

- The text "... 12 and 22 (view center point, in WCS) ..." should read "... 12 and 22 (view center 
point, in DCS) ...".

- It should also be noted that groups 68 (status field) and 69 (ID) are never saved.

5.4 - AutoLISP Programmer's Reference

Chapter 1

- "Function Libraries--Automatic Loading", page 15. The following should replace the last 
sentence in the second paragraph:

- When a menu file is loaded (either by starting a drawing or issuing the MENU command), 
AutoCAD searches the directory containing the newly loaded .mnu file for a .mnl file of the same
filename. If a matching .mnl file is found AutoCAD loads the AutoLISP code in that file after 
loading the menu file (e.g., AutoCAD loads the file acad.mnl after loading the acad.mnx 
compiled menu file).

- "Function Libraries--Automatic Loading", page 15. The following should be added to the 
description of the .mnl file.

- If a menu file is loaded with the AutoLISP (command) function, its associated .mnl file is not 
loaded until the entire AutoLISP routine has run to completion.



Chapter 4

- "(entget)", page 102 and "(entmod)", page 107. These sections should include the following 
information:

- Before performing an (entget) or (entmod) on Vertex entities, you should read or write the 
header (Polyline entity) for the Polyline to which they belong. If the Polyline entity most recently 
processed is different from the one to which the Vertex belongs, width information (the 40 and 41
groups) can be lost.

- "(*error*)", page 111. This incorrectly states that your *error* function should not include any 
calls to the command function without arguments. This paragraph should be replaced with the 
following:

- Your *error* function can include calls to the command function without arguments (i.e., 
(command) ); this will cancel a previous AutoCAD command called with the command function.

- "(grread)", page 121.  Value 16 (bit 4) of the <allkeys> argument is not supported.

- "(grread)", page 123. The text "... grread returns a type 11 code ..." should be replaced with "... 
grread returns a type 6 or type 11 code ...".

- "initget - Keyword Specifications", page 127.  The following information should be added to 
this section:

- A legal keyword can contain letters, numbers, or hyphens (-).

- "(tblnext)", page 157.  The following note should be added to the (tblnext) description:

Hint: Since the (vports) function returns current VPORT table information, it might be more 
appropriate to use (vports) as opposed to (tblnext).

Appendix B

- "Entity Group Codes", page 200. The meaning of Text entity group code 41 
should be "Relative X-scale factor (optional; default: 1.0)

Appendix C

- "Error Codes", page 210. The following error code should be added to the "On-line program 
error codes" table:

| Value | Meaning |
| | |
| 85 | AutoLISP/ADS operation attempted and prohibited |
| | while a dialogue box was displayed |
|   |   |



5.5 - AutoCAD Development System Programmer's Reference

Chapter 2

- "File" Search, page 57. The third line of code in the example,

if (ads_newrb(result) == NULL) {

- should read as follows:

if ((result = ads_newrb(RTSTR)) == NULL {

Chapter 3

- "Filtering for Extended Entity Data", page 88.  The examples on pages 88 and 89 are incorrect.  
They should be replaced with the following examples: 

Example 1:

eb1.restype = 0; /* Entity type */
strcpy(sbuf1, "CIRCLE");
eb1.resval.rstring = sbuf1;  /* Circle */
eb1.rbnext = &eb2;
 
eb2.restype = -3;/* Extended entity data */
eb2.rbnext = &eb3;
 
eb3.restype = 1001;
strcpy(sbuf2, "APPNAME");/* Application name */
eb3.resval.rstring = sbuf2;
eb3.rbnext = NULL;
 
/* Select Circles with XDATA registered to APPNAME */ 
ads_ssget("X", NULL, NULL, &eb1, ss);

Example 2:

eb1.restype = 0; /* Entity type */
strcpy(sbuf1, "CIRCLE");
eb1.resval.rstring = sbuf1;  /* Circle */
eb1.rbnext = &eb2;
 
eb2.restype = -3;/* Extended entity data */
eb2.rbnext = &eb3;
 
eb3.restype = 1001;
strcpy(sbuf2, "APP1");   /* First application name */
eb3.resval.rstring = sbuf2;
eb3.rbnext = &eb4;
 



eb4.restype = 1001;
strcpy(sbuf3, "APP2");   /* Second application name */
eb4.resval.rstring = sbuf3;
eb4.rbnext = NULL;
 
/* Select Circles with XDATA registered to APP1 and APP2 */
ads_ssget("X", NULL, NULL, &eb1, ss);

Example 3:

eb1.restype = 0; /* Entity type */
strcpy(sbuf1, "CIRCLE");
eb1.resval.rstring = sbuf1;  /* Circle */
eb1.rbnext = &eb2;

eb2.restype = -3;/* Extended entity data */
eb2.rbnext = &eb3;

eb3.restype = 1001;
strcpy(sbuf2, "APP1,APP2");  /*  Application names */
eb3.resval.rstring = sbuf2;
eb3.rbnext = NULL;
 
/* Select Circles with XDATA registered to APP1 or APP2 */
ads_ssget("X", NULL, NULL, &eb1, ss);

Example 4:

eb1.restype = 0; /* Entity type */
strcpy(sbuf1, "CIRCLE");
eb1.resval.rstring = sbuf1;  /* Circle */
eb1.rbnext = &eb2;

eb2.restype = -3;/* Extended entity data */
eb2.rbnext = &eb3;

eb3.restype = 1001;
strcpy(sbuf2, "APP[12]");/*  Application names */
eb3.resval.rstring = sbuf2;
eb3.rbnext = NULL;
 
/* Select Circles with XDATA registered to APP1 or APP2 */
ads_ssget("X", NULL, NULL, &eb1, ss);

- "Transforming Selection Sets", page 94. In the second example of the dragsample() function, the
declaration of the matrix argument should be as follows (as it is in the first example):

ads_matrix matrix;



- "Entity Name Functions", page 97. This section should include the following information:

- If a call to ads_entsel(), ads_nentselp(), or ads_nentsel() returns RTERROR, and you want to 
know whether the user picked a point that had no entity or simply pressed <CR>, you can inspect 
the value of the ERRNO system variable. If the user picked an empty point, ERRNO equals 7 
(OL_ENTSELPICK). If the user pressed <CR>, ERRNO equals 52 (OL_ENTSELNULL). (You 
can use the symbolic names if your program includes the header file, ol_errno.h.)

CAUTION: You should inspect ERRNO immediately after ads_entsel(), ads_nentselp(), or 
ads_nentsel() returns. A subsequent ADS library call can change or clear the value of ERRNO.

- "Anonymous Blocks", page 110.  Lines 5 through 8 of the example at the  bottom of the page 
are incorrect.  They should be replaced with the following lines of code:

ads_point pnt1 = { 0.0, 0.0, 0.0 };
entlist=ads_buildlist(RTDXF0, "BLOCK", 
 2, "*ANON", 
 10, pnt1,
 70, 1,
 0);

Chapter 4

- "ads_entget()", page 145 and "ads_entmod()", page 149. These sections should include the 
following information:

- Before calling an ads_entget() or ads_entmod() for Vertex entities, you should read or write the 
header (Polyline entity) for the Polyine to which they belong.  If the Polyline entity most recently 
processed is different from the one to which the Vertex belongs, width information (the 40 and 41
groups) can be lost.

- "ads_getfiled", p. 156. In the paragraph below figure 4-2, replace the first two sentences with 
the following sentences:

- If the dialogue box gets a filename from the user, ads_getfiled() sets the string in the result 
argument to a string specifying the filename; otherwise, ads_getfiled() sets the string in result to 
NULL. The ads_getfiled() function allocates the pathname string. Your program is responsible for
freeing the string by calling free() (if result is a static buffer) or ads_relrb() (if result is a 
dynamically allocated
buffer).

- "ads_getkword", page 160. In the final paragraph on p. 161, replace the words "RTNONE or 
RTKWORD (for arbitrary input)" with "RTNONE (if the
user enters a null response or arbitrary input)".

- "ads_getsym", p. 162. Delete the last sentence of the first paragraph, "It also fails if the symbol 
is not bound, or is bound to nil.", and replace it with the following sentence:



- If the symbol not bound or is nil, ads_getsym() returns RTNORM and sets the value argument to
NULL.

- Replace the first sentence of the second paragraph with the following
sentence:

- The ads_getsym() function returns RTNORM if it succeeds; if it fails,
ads_getsym() returns RTERROR.

- "ads_getsym", page. 162. The ads_getsym() function can access AutoLISP symbols that 
AutoLISP cannot. (Such symbols can only be created by ads_putsym() calls.) This will cause an 
error in a future upgrade or release of AutoCAD. Your programs should not rely on this 
capability.

- "ads_grread()", page 165. The text "... ads_grread() returns a type 11 code ..." should be 
replaced with "... ads_grread() returns a type 6 or type 11 code ...".

- "ads_initget() - Keyword Specifications", page 170.  The following information should be added
to this section:

- A legal keyword can contain letters, numbers, or hyphens (-).

- "ads_putsym", p. 180. An ads_putsym() call can create a new AutoLISP symbol that AutoLISP 
cannot access -- for example, by including illegal characters in the symbol name, such as "pair(s".
An ads_getsym() call can access such symbols, but they will cause an error in a future upgrade or 
release of AutoCAD. Your programs should not rely on this capability.

- "ads_polar", page 180.  All references to 'ptres' should be changed to 'result'.

- "ads_regfunc", page 182.  The following sentence should be added to the ads_regfunc() 
description:

- An external function handler registered by ads_regfunc() must have no arguments and must 
return an integer or one of the application result codes--either RSRSLT or RSERR as appropriate.

Appendix B

- "Entity Group Codes", page 255.  The group code 40 is missing from the ATTRIB entity group. 
The following should be added to that section:

| | | |
| ATTRIB | 40 | Text height |
| | | |

- "Entity Group Codes", page 258. The meaning of Text entity group code 41 should be "Relative 
X-scale factor (optional; default: 1.0)



5.6 - AutoCAD Extras Manual

Chapter 2

- "REIDGE  Edge Detection and Extraction", page 35.  The third sentence of the first paragraph 
should be replaced with the following:

- Specifying values from 1 to 255 set the threshold for RIEDGE detection.

Chapter 3

- "Tips and Techniques", page 85-95. This section should include the following subsection:

SOLCHP Command

- While in the SOLCHP command, if you perform any operation that forces the screen to redraw 
(like entering 'redraw), all of the primitives for the selected solid or region may be displayed.  
Entering the SOLCHP Instance, Replace, or Delete option while your grid is on will also display 
all the primitives in some cases.

5.7 - AutoCAD Tutorial Manual

F2 is the help key, not F1 as shown in the tutorial.

Figure number on page 168 should be 6-19.

Page 252 has incorrect information regarding creating a script.  Entering 2 at the beginning of the 
script will not work in Windows.  Just enter the text of the script as shown in the example.

Example 3 on page 252 will not launch a script in windows.  Enter "script" at the command 
prompt and select the script filename from the dialog box.


